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Foreword

Thank you for deciding to purchase our product. We wish you total success in accomplishing your
measurement assignments with the help of your hardware and software. If you have any open questions
about our products, please contact our Hotline (hotline@imc-tm.de).

Disclaimer of liability

The contents of this documentation have been carefully checked for consistency with the hardware and
software systems described. Nevertheless, it is impossible to completely rule out inconsistencies, so that
we decline to offer any guarantee of total conformity.
We gratefully accept any suggestions for improvements, please contact our Hotline (hotline@imc-tm.de).

We reserve the right to make technical modifications of the systems.

Copyright

© 2021 imc Test & Measurement GmbH, Germany

This documentation is the intellectual property of imc Test & Measurement GmbH. imc Test &
Measurement GmbH reserves all rights to this documentation. The applicable provisions are stipulated in
the "imc Software License Agreement".
The software described in this document may only be used in accordance with the provisions of the "imc
Software License Agreement".

Open Source Software Licenses

Some components of imc products use software which is licensed under the GNU General Public License
(GPL). Details are available in the About dialog.

A list of the open source software licenses for the imc measurement devices is located on the
imc STUDIO/imc WAVE installation medium in the folder "Products\imc DEVICES\OSS" or "Products\imc
DEVICEcore\OSS". If you wish to receive a copy of the GPL sources used, please contact our Hotline.

mailto:hotline@imc-tm.de
mailto:hotline@imc-tm.de
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6 General Notes

1  General Notes

1.1  Before you Start
Dear user.

1. The software you have obtained, as well as the associated manual are directed toward competent
and instructed users. If you notice any discrepancies, we request that you contact our Hotline .

2. Updates during software development can cause portions of the manual to become outdated. If
you notice any discrepancies, we request that you contact our Hotline.

3. Please contact our Hotline if you find descriptions in the manual which you believe could be
misunderstood and thereby lead to personal injury.

4. Read the enclosed license agreement . By using the software, you agree to the terms and
conditions of the license agreement.

1.2  Notes / Quality Management

Quality Management

imc Test & Measurement GmbH holds DIN-EN-ISO-9001
certification since May 1995. You can download the CE
Certification, current certificates and information about the imc
quality system on our website:
www.imc-tm.com/quality-assurance/.

imc Warranty

Subject to the general terms and conditions of imc Test & Measurement GmbH.

Product Improvement and change requests

Please help us to improve our documentation:

· What terms or descriptions are incomprehensible?

· What additions and enhancements you suggest?

· Where have material mistakes slipped in?

· Which spelling or typing errors have you found?

Responses and other feedback should be directed to the Hotline  (phone / e-mail)
or by writing to: imc Test & Measurement GmbH, Voltastrasse 5 in 13355 Berlin, Germany

7

8

7

http://www.imc-tm.com/quality-assurance/
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1.3  imc Customer Support / Hotline
If you have problems or questions, please contact our Customer Support/Hotline:

imc Test & Measurement GmbH

Hotline (Germany): +49 30 467090-26

E-Mail: hotline@imc-tm.de

Internet: www.imc-tm.com

International partners

For our international partners see www.imc-tm.com/distributors/.

Tip for ensuring quick processing of your questions:

If you contact us you would help us, if you know the serial number of your devices and the version info
of the software. This documentation should also be on hand. Thank you!

· The device's serial number appears on the nameplate.

· The program version designation is available in the About-Dialog (click on the symbol  in the
menu bar).

1.4  Documentation - Help
All imc STUDIO products come with help (CHM or EXE format). In the menu bar, click on the symbol  to
open the help. The help may also contain parts shared imc software components. These parts may differ
from the rest of the help in terms of style and structure. All help files are equipped with a full text search
functionality and have an index.

Note Notes on the descriptions and the screenshots

The screen shots appearing in this documentation were created with a variety of Windows versions
and their appearance may thus differ from that of your installed program.

imc STUDIO works with user groups and access rights. The user group has wide-reaching influence
on the visibility and/or operability of menus, icons, etc. Note that in all imc STUDIO documents the
administrator roll is assumed to be filled. All descriptions are therefore related to the full utilization
of the user interface.

The following descriptions and screenshots always pertain to the view with the full scope of
functions (Complete). Many of these functions are also found in the minimized view at another
location.

mailto:hotline@imc-tm.de
http://www.imc-tm.com
http://www.imc-tm.com/distributors/
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1.5  imc Software License Agreement
imc Test & Measurement GmbH
Voltastrasse 5
13355 Berlin
Commercial register: Berlin-Charlottenburg HRB 28778
Managing director: Kai Gilbert, Ralf Winkelmann

imc Test & Measurement GmbH
Terms and Conditions

Governing the Use of imc Test & Measurement GmbH Software
As of: January 10, 2020

§ 1 Objects of the Agreement

(1) In addition to the "General Terms and Conditions Governing imc Test & Measurement GmbH Deliveries and
Services to Customers", these terms and conditions apply to all contracts concluded with  imc Test &
Measurement GmbH (hereinafter referred to as "imc") which involve the transfer of rights of use to any software
developed by imc (standard software, software created or adjusted specifically for the Customer, which is
recorded on the machine-decodable data carriers such as data files, databases and database material, updates,
upgrades, releases, etc., including corresponding documentation, information and materials, hereinafter referred
to as "Software").

(2) The Software is provided to the Customer as an executable object program on machine-decodable data carriers
specified in the "Objects of the Agreement". The Software's product documentation is also supplied to the
Customer either in print or on a machine-decodable data carrier. Unless otherwise expressly agreed in writing,
the Customer is not issued the source code of the Software.

§ 2 Rights of Use, Scope

With regard to any transfer of rights of use to Software created by imc, the following provisions apply:

(1) Basic provisions

 a) The Customer is granted a non-exclusive and – subject to the terms and conditions governing the use of
Software by third parties, resale and leasing – non-transferrable right of use to the Software for its own
purposes. "Use" signifies running the programs and editing the data records.

 b) Until each due fee is paid in full, the Customer is entitled to use the Software solely on a revocable basis. If the
Customer is in default with regard to the payment of fees, imc is entitled to revoke the use of the respective
services for the duration of the default. The Customer is granted the permanent right to use copyright
protected services, in particular the Software, only upon full payment of the agreed fee.

 c) The Customer agrees to undertake appropriate precautionary measures to prevent unauthorized access by
third parties to the Software. The original data carriers and the data carries used to make copies as per the
agreement, as well as the documentation, are to be stored in a secure location. Employees are to be notified
that the production of copies beyond the scope of the agreement is not permitted.

 d) If the right of use is revoked or expires due to another reason, the Customer is obligated to return to imc the
Software, the copies made by the Customer and the documentation. Provided that a physical return of the
Software and the copies is not possible due to technical reasons, the Customer is obligated to delete such and
confirm deletion to imc in writing.

(2) Reproduction

 a) The Customer is entitled to make copies of the Software only if copies are necessary to use the Software in
accordance with the contract. The following are considered cases in which reproduction is necessary:
installation of the Software from the original data carrier onto the hard disk drive of the hardware used, as
well as loading the Software into the computer memory. 

 b) The Customer is entitled to create a backup copy if such is necessary to safeguard future use. Copies may only
be made for other purposes after prior written consent has been issued by imc. 

 c) The Customer is not allowed to make any reproductions other than those expressly permitted under the
provisions of this agreement.
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(3) Use of the Software by Third Parties, Resale and Leasing

 a) The Software may be used for the purposes stipulated in this contract, in particular for the Customer's
business operations. Access to the Software may also be provided to parties which rely on using the Software
as instructed by the Customer. In particular, the Customer is entitled to operate the Software or allow the
Software to be operated on data processing devices, which are located on the premises of and are directly
owned by a third party company (outsourcing). The prohibition against multiple use remains unaffected. 

 b) The Customer may permanently sell or give the Software to third parties provided that the Customer is
granted permanent use of the Software. In the context of its period of use, the Customer may temporarily
transfer the Software to third parties for a fee or free of charge. The prohibition against multiple use remains
unaffected. The Customer is expressly notified that transfer to third parties is not permitted and use by third
parties is technically not possible if an individual license must be acquired or an individual activation is
required for third party usage, such as in the case of runtime licenses.

 c) With regard to the valid use of Software by a third party, the Customer is obliged to ensure that the third
party acknowledges the provisions of this agreement governing the rights of use as binding for such third
party. The Customer may not transfer Software and documentation to third parties if there are grounds to
suspect that the third party may infringe upon the provisions of this agreement governing the rights of use, in
particular with regard to the unauthorized production of copies. 

 d) Subject to the provisions stipulated in § 4 Paragraphs 1 and 2 or a deviating express agreement in writing, the
Customer may not use the Software while the Software is being used by a third party (prohibition against
multiple use); in the event that the Software is transferred to the third party, the customer is obliged to
surrender to imc all Software copies including, if applicable, all existing backup copies, or to destroy copies
not surrendered.

(4) Decompilation

The reverse translation of the provided program code into other code forms (decompilation), disassembling and
other forms of reverse engineering of the various production phases of the Software is not permitted. If interface
information is required to achieve the interoperability of a separately created computer program, such may be
requested from imc, or a third party to be named by imc, for a minor fee. Section 69 e of the German Copyright
Act ("UrhG") remains unaffected by this provision.

(5) Changes by imc

If imc conducts adjustments, changes or enhances the Software on behalf and on account of the Customer, the
Customer thus acquires the corresponding rights of use to the changes or enhancements of the Software to
which he is entitled according to the stipulations of this agreement.

(6) Exceptional Usage Requests by the Customer

If the Customer requests to use the Software according to terms which deviate from the requirements stipulated
in Paragraphs 2 through 5, this exceptional use of the Software must be agreed in writing by imc. In such an
instance, the Customer agrees to provide imc with information about the desired scope of use, the pertinent field
of application, etc. If imc subsequently grants a license covering the Customer's special intended use, the parties
agree that a new license fee is owed by the Customer, which is independent of payments made by the Customer
for the previously existing license.

§ 3 Copyright, Protection of the Software

(1) The intellectual property, in particular the copyright as well as all industrial property rights and trade secrets, are
retained by imc and are not transferred to the Customer. The Customer's ownership of the machine-decodable
data carries and data processing units remains unaffected.

(2) Copyright notices, serial numbers as well as designations and reservations of rights which serve as program
identification or a protective right may not be removed or changed. The Customer is obliged to transfer the
existing protective right notices to all copies. In particular, backup copies of the Software must be expressly
designated as such.
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§ 4 License Types, Multiple Use

(1) In the case of a Single-User License, the Software may be activated and run on only one data processing unit.
"Activation" refers to the process of transferring the license to the data processing unit.

If the technical specifications for the Software permit a second activation, then the Customer may additionally
activate the Software on a second data processing unit. However, the Software may only run on one data
processing unit at any one time, not on both simultaneously.

(2) With a Network License, the Software may be run on as many data processing units as the amount of licenses
obtained. In this case a central data processing unit acts as the license server for which the activation process is
performed.

If the technical specifications for the Software permit a second activation, then the Customer may additionally
activate and run the Software on as many data processing units as the amount of licenses obtained. However,
these additional data processing units must be used by the same users who operate the Software via the license
server.

(3) Subject to the provisions in Paragraphs 1 and 2 or a deviating express agreement in writing regarding network
use, multiple use of the Software is not permitted.

(4) If the data processing unit is changed, the Customer is obliged to delete the Software from the hard disk drive of
the previously used hardware.

§ 5 Trial Version

If the Software used is a free trial version, then the following additional limitations apply:

(1)  The trial version only entitles the user to test the Software. In particular, commercially productive utilization is
not permitted.

(2)  The rights of use granted expire after the elapse of a period stated in the product description.

§ 6 License Key

(1) Upon delivery of the Software the Customer receives a License Key. Using this License Key, the Customer is able
to activate the Software purchased. By means of this License Key the Customer can also view his license status
and order updates and upgrades.

(2) The License Key is to be protected against access by third parties in order to prevent misuse. If, however, a third
party gains unlawful access to the Key, the Customer is obliged to notify imc immediately via telephone, as well
as in writing, so that the previous License Key may be suspended and a new one issued.

§ 7 Conclusion

(1) The law of the Federal Republic of Germany shall apply under exclusion of private international law. The
provisions of the UN Convention on Contracts for the International Sale of Goods (CISG) do not apply.

(2) The place of performance for all obligations arising from this agreement is imc's registered seat. Insofar as the
Customer is a merchant as defined by the German Commercial Code (HGB), a legal entity under public law, or a
special asset under public law, the exclusive place of jurisdiction for all disputes directly or indirectly arising from
the contractual relationship is agreed as imc's registered seat. The same applies to persons who have no general
place of jurisdiction in Germany, as well as to persons who have moved their place of residence or usual
whereabouts abroad since conclusion of the contract, or whose place of residence or usual whereabouts is
unknown at the time the action is filed. In addition, imc is entitled to file suit at the statutory venue.

(3) Oral side-agreements are not valid. Deviating or supplementary conditions as well as modifications of this
contract, including this written requirement clause, are only valid if agreed in writing and expressly marked as a
modification or supplement.

(4) If certain provisions of this contract are inoperative or unfeasible, this does not prejudice other provisions of the
contract. The contracting parties agree to contractually substitute an operable provision which approximates the
commercial intention of the contract as closely as possible for any inoperable one.
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2  Overview
This document describes the first steps in operating imc STUDIO and the installation of additional imc
products. This document uses textual references to the product documentation.

imc STUDIO is the common framework forming a product package through the combination of modular
components (plug-ins).

Which components are available depends on the product installation (order).

Chapter overview

Synopsis Chapter

Startup operations for imc STUDIO - installation and
product configuration prior to first use

· System requirements

· Installation / Uninstall

· Product Configuration / Licensing

· The first start

· Device connection / Network / Firewall

The first steps in connecting with the device
· Setting Up - Connect the device

· Firmware Version

Data storage: How are data stored and loaded
· Experiments, Projects and the Database

· Ribbon "Project": Open / Save experiments

Navigation through the entire software
· Navigation Pane

The software user's interface is flexible. Saving and
restoring of views

· Saving / Loading views

Customer Support - Hotline

Questions or problems? Contact our Customer Support / Hotline .

12
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3  Setting Up - Software

3.1  System requirements
Supported operating systems  

Windows 10*  

Windows 8.1  

*released in conformance with the version of Windows 10
applicable at build date of imc software

 

Minimum requirements for the PC 1 Recommended configuration for the PC 2

Hyper-threading or Dual Core processor with 2 GHz clock
speed

Quad Core processor with 2 GHz clock speed or
higher

2 GB RAM (32 bit) / 4 GB RAM (64 bit) 3 GB RAM (32 bit) / 8 GB RAM (64 bit)

10 GB free hard disk space (NTFS format) 10 GB free hard disk space (NTFS format)

Display resolution 1280 x 768 Display resolution: 1280 x 1024 or more

 64 bit operating system

1 A system with minimum requirements is not adequate for connection with multiple devices and complex design tasks with the
imc STUDIO Developer. Use such systems preferably only for data monitoring purposes.

2 The requirements for the PC’s configuration increase with the number of devices involved and the scope of the
Data Processing-calculations to be performed.

Supported Measurement Devices

Which devices you can use in imc STUDIO is described in the documentation on the "Setup" > "Device
Overview", as well as in the "Technical Data Sheet". For the purpose of connecting with imc STUDIO
Monitor, the devices must additionally have at least 32 MB of internal (interface) device memory
available (which is assured for all current device models, except for a limited number of imc CRONOS-PL
and imc CRONOS-SL devices dating back to before 2007).
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3.2  Installation - Preparation

Software requires a license

This means that the program may only be started upon obtaining a license (see Product Configuration /
Licensing ).

Administrator rights required

For the purposes of installation and uninstallation, a user account with administrator privileges for the
PC is required.

If you are logged on to the PC without administrator rights, log yourself out and log back on with an
administration-level user account. If you don't possess the appropriate account type, you will need the
support of your system administrator or IT department.

See also Notes on Windows User Account Control .

Restarting the computer in the process of installation

During the installation process, the installation program will prompt you to restart the PC.

Note Restarting

After the restart, login to the same user account with which you had previously begun the
installation.

Coexisting applications: imc STUDIO, imc STUDIO Monitor, imc WAVE, ...

Some imc programs are installed as an independent and specially adapted instance of imc STUDIO. They
are based on imc STUDIO.

Unless otherwise stated, these programs are installed and used in parallel. As long as these instances are
based on the same version of imc STUDIO (e.g. 5.2R1), they are all subordinated to the same program
installation, which means they share resources.

For this reason, installation of the instances in this case must be performed in
one single shared Setup procedure. Any attempt to perform installation in
succession or subsequently will cause the already existing instances to be
deleted.

This applies particularly to the joint and parallel installation of imc WAVE and
imc STUDIO, which must be performed in a single step.

Do not install
imc STUDIO and
imc WAVE in
succession, but always
at the same time.

Update or parallel installation

The Setup utility checks whether any version of imc STUDIO is currently installed on the computer. If so,
it can be uninstalled by means of the Setup. An associated confirmation prompt is posted in that case. All
user data such as the database remain intact.

You can keep both versions installed in parallel, as long as the version numbers are different (e.g. 5.0
and 5.2). The new version can be installed in the same folder (default case: "C:\Program Files (x86)\imc"
for 64-bit Win10). In this folder, a new subfolder with the new version number is created for imc STUDIO.

26

16
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In both cases, you are able to adopt a variety of settings from the old versions. These include the project
settings and views. By contrast, other settings such as the product configuration and the database path
need to be set up from the beginning.

Adopting the settings with the help of the existing database (recommended)

If you wish to continue using the existing database, the possible settings will
be adopted. For a parallel installation, two data bases are needed. Create a
copy so that the old imc STUDIO version can continue to work with the
existing database. A confirmation prompt about making a copy is posted.
See: Update with the help of the existing database .

Adopting the settings without using the existing database

You can apply the settings, such as the views, without using the database. To
do this, save and import the appropriate settings.
See: Update without using the existing database .

Please also observe the
notes regarding the
update and
compatibility on our
website  under FAQ!

The subsequent procedure - an overview

Follow the installation program instructions (see: "Installation step by step ").

· The installation process first checks whether the required system software is installed. If ones is
missing, it will be installed automatically.

· After restarting the system, the selected  products are installed.

· After the installation is concluded, it is possible to start imc LICENSE Manager directly to activate
your license.

· Once the license has been activated, you can use the products.

Uninstalling

To uninstall the product, use the Windows Control Panel/Settings and select the respective entry:

· "Control Panel" > "Programs" (Uninstall a Program) (Windows 7)

· "Settings" > "Apps & features" (Windows 10)

Reference See also

· Recommended Virus Scanner Settings

· Changing Languages and Installing Additional Languages

15

15
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3.2.1  Update with the help of the existing database
If you continue to use the existing database, whatever settings are possible will be adopted. This includes
Views, any Setup-columns created by the user, the user administration and all experiments.

If you wish to run multiple versions of imc STUDIO or maybe restore an older version at a later time,
create a copy of the database.

Note The database

It is impossible to use the imc STUDIO database by both versions in parallel.

· If the same path is selected in the new imc STUDIO version, the database is used automatically.
When loading old experiments, a note is posted in the logbook that the experiments belong to an
older version. Once saved, they can no longer be loaded with the old version.

· If the database structure has been altered, you will be notified of this. A dialog for performing
conversion appears. There you can convert the database or have it copied beforehand. After the
conversion, the entire database can no longer be used with the old version.

Note Using new views

· Be aware that the new version provides new functions, such as new or enhanced Setup pages and
new menu items.

· Use of the new Views is recommended, in order for these new functions to be accessible! Please
look under "What's new" whether there have been any changes in this regard.

· User-made columns such as meta data columns are not automatically inserted into the pages. The
configurations of these columns, however, is adopted from the old View. You can re-insert these
columns at the desired position (by means of the Column Chooser).

· Multiple views are provided. Select a view and add whatever Setup pages are required or saved,
and save the view under a new name.

· How to save Views is explained in the imc STUDIO documentation under "Views ".

3.2.2  Update without using the existing database
In imc STUDIO, various settings were saved with the respective project and
apply to all the experiments it contains. Among other things, these include the
view settings: user-defined views, column configurations (e.g. metacolumns).

In order to retain these settings in the new version after having performed
the update without using the existing database, export of the settings are
necessary.

Please first check which
settings you will need.

· If you wish to reuse all of the project's settings, export the project settings (by means of the
Projects-dialog: Menu ribbon: "Project" > "Manage Project").

· If you wish to reuse only the viewing settings, export the views .

60

61
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3.2.3  Notes and Troubleshooting

Notes on Windows User Account Control

Do not change the user account

Example of a password request.
Select "No".

With Windows, installation can be started without
administrator rights. In this case, the operating
system requires selection of a user account and
associated password, as shown in the example
below.

Do NOT continue with the
installation in this way, otherwise it
will be incorrect. Select "No".

Confirm the prompt by the user account control

Select "Yes", to start the installation.

When you are logged in to a user account
possessing administrator rights, you may receive a
prompt by the Windows User Account Control
(UAC) to allow changes. Select "Yes" as shown
below.

Notes on the security software

Some virus scanners prevent correct installation of imc programs. We are currently aware of this
affecting products from the companies McAffe and ESET. In principle, almost any virus scanner can have
settings possibilities which prohibit necessary functions during installation.

For installation purposes, certain steps are necessary, such as:

· registration of programs for Autorun

· registration of programs as a service

· running of scripts from the TEMP-folder

· ...

The error profile may include various messages during installation. Or installed programs failing to
launch.

In such cases, please contact your administrator to find out whether certain rules can be suspended for
the duration of the installation. For any further questions, please contact our Hotline .7
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3.3  Installation Step by Step
Actual texts appearing in the user interface may differ from those shown in the screen shots, depending
on the product configuration (path/version name).

Installation from the product DVD

· Close all programs.

· Insert the product DVD.

· In usual cases, the Setup program will automatically start after a brief delay. Otherwise use the
Windows Explorer and start the installation program from the DVD.

Installation after Download

· If you have obtained the product electronically (download, Email), simply start the installation
program manually.

Installation language settings

Selecting the language during installation

When you start the installation, you first see a
dialog for selecting the installation language.

Performing installation

Installation setup welcome page

Once you have selected the language, the
installation setup starts with a welcome page:
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Before starting installation

On the installation setup's next page, you are
offered the following choices:

· open the "Readme"-file,

· open the "Getting Started"-document,

· separate installation of imc LICENSE Manager
and

· display of the DVD contents.

License agreement

You must accept the license agreement to
continue the installation.

Entering the installation path

In the next step, select the file path where the
products should be installed. For each imc
product, a separate subfolder is created in this
path (e.g. imc STUDIO 5.2). Therefore it is
recommended that the path should end with "..
\imc".
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Select the products / Installation type

Now you can select which components should be installed. There are three
types available:

· Demo

· Auto

· User-defined

However independent from the selected installation type the products that
are always included are:

· imc LICENSE Manager for managing the licensing, and

· imc Shared Components, proving common components of the imc
products, such as the curve window.

"User-def ined" gives
you the ability to affect
all installation settings.

Details on the types and the respective subsequent installation steps are provided in the associated
sections below.

Note Note on re-configuring imc STUDIO

Regardless of which variant of the installation is selected, when imc STUDIO is installed, all
components/plug-ins are included. This way, after successful installation it is possible to adapt the
configuration at any time by means of the product configuration  and to select the appropriate
edition.
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3.3.1  Demo and Auto
The installation types Demo and Auto are only slightly different. For both types the installation settings
are already configured. If you need further settings please choose the user-defined installation type .

The imc STUDIO edition and the necessary components/plug-ins can be adapted at any time subsequent
to successful installation by means of the product configuration .

Installation: Demo Installation: Auto

Use the installation type "Demo" in order to test the full
scope of imc STUDIO for 30 days. No other products
which require a password will be installed.

Use the installation type "Auto" in order to install the
standard imc STUDIO edition including all necessary
components. Optionally, the password-protected
sensor management system imc SENSORS is installed.

The installation type is installed along with imc Shared Components and imc LICENSE Manager:

Installation: Demo - Components Installation: Auto - Components

imc STUDIO Developer (Demo) 1 imc STUDIO Standard 2

imc DEVICES 3 imc DEVICES 3

imc FAMOS Reader 4 + Enterprise (Demo) imc FAMOS Reader 4

imc Format Converter imc Format Converter

 optionally imc SENSORS 5

Installation: Demo - Description

1: The associated Demo license must be activated
after concluding installation by means of
imc LICENSE Manager, otherwise it is not possible
to start imc STUDIO.

Once the demo trial period has elapsed, use the
product configuration  to covert the edition to
the license you have purchased.

Installation: Auto - Description

2: The edition imc STUDIO Standard requires the
purchase for license.

The associated license must be activated after
concluding installation by means of
imc LICENSE Manager, otherwise it is not
possible to start imc STUDIO.

3: As a package of device drivers and firmware used by imc STUDIO.

4: The imc FAMOS Reader is freeware which also needs to be registered using imc LICENSE Manager.

 5: Optionally, imc SENSORS is installed, which is a
tool for administering sensors. This product
requires a password for installation. If you do
not wish to install imc SENSORS, you can de-
select it.

Installation start follows directly (see: "Starting the installation ").
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3.3.2  User-defined
This installation type enables the user to choose a detailed configuration. Based on your selection of
components desired, different installation steps are displayed.

Note Who should select User-defined installation

Use the installation type User-defined if you wish to configure the individual products.

With this type, it is possible to install password-protected components. Further, you can install and
configure additional imc products such as imc FAMOS.

Note that some components can require a separate license.

Selecting components

Selecting User-defined installation

Once you have selected the installation type
"User-def ined", it is possible to select/de-select
the desired components in the box at the bottom.

imc LICENSE Manager and
imc Shared Components are included, as well as
the necessary system component, otherwise the
installed products will not function properly.

Selection Description

Required system
components

System components require using of imc products.

imc LICENSE Manager imc LICENSE Manager enables the display and activation of all imc software products
requiring a license.

imc Shared Components Shared components of the imc products, such as the curve window.

imc SENSORS imc SENSORS is a turnkey database program applicable across different measurement
devices, for administering and editing freely definable sensor information.

imc STUDIO imc STUDIO is modular software platform handling all aspects of modern
measurement technology from simple data acquisition to sophisticated test
configurations.

imc STUDIO Monitor License-required component for imc STUDIO

imc WAVE imc WAVE is a software package for NVH (Noise Vibration and Harshness) analysis. It
is based on imc STUDIO and is installed as a separate instance of imc STUDIO. It can
be equipped with multiple, separately licensed analyzers.

Firmware and driver
package imc DEVICES

Package of device drivers and firmware required by imc STUDIO and imc WAVE for
imc devices.

imc FAMOS imc FAMOS is a program for analyzing, evaluating and documenting measurement
results.

imc Format Converter Converts imc measurement data to other formats such as EXCEL and ASCII.
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Required system components

Required system components (example)

In the next step, the system components which
the products selected require are displayed, along
with a note about which are already installed on
your system. It is also possible to re-install any
already installed components. Which components
are missing/present depends on the system and it
update status, so that the illustrations below are
intended as an example only.

Configuring imc Shared Components

Configuring imc Shared Components

In this installation step, it is possible to install
password-protected components of
imc Shared Components.

Option/Component Description

COM Products The imc COM programming interface is a system integration tool 

Class Counting Kit Function library for imc COM products

Spectral Kit Function library for imc COM products
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Password for imc SENSORS

Password prompt for imc SENSORS

If you have selected imc SENSORS, you are
prompted to enter the password prior to
installation. But if you do not wish to install
imc SENSORS, de-select it here.

 Configuring imc STUDIO

Configuring imc STUDIO

It is possible to make settings for your licensed
product edition here. In consequence, later
product configuration  can be omitted.

Option/Component Description

Licensed edition Information on the editions is provided in the Technical datasheet for imc STUDIO.

Install all languages This option installs imc STUDIO in all available languages. If you do not need any extra
languages, you can shorten the installation process.

Please note that some functions require other languages. E.g. foreign-language
parameter sets can only be imported if the corresponding language is installed.

If the option is de-selected, then English and the operating system's language (if
available) are installed automatically. If desired, all other supported languages can be
installed later (see section "Installing additional languages ").

Links Program starting links can be created on the Desktop.
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Configuring imc DEVICES

Configuration imc DEVICES

Here, you can install optional components of the
imc DEVICES device driver package, which are
used by imc STUDIO and imc WAVE.

Option/Component Description

CAN, LIN, ETHERNET,
XCPoE, Flexray,
PROFIBUS, IPTCom, MVB

For measurement devices with one of these Fieldbus terminals

J1587 For measurement devices with a J1587-Bus terminal

ARINC/AFDX For measurement devices with a ARINC- or AFDX-Bus terminal

Extension for Windows-
Explorer

Access to the device hard drive via the MS Windows-Explorer

LabVIEW(TM) VIs Library for accessing the imc devices via LabVIEW(TM)

Service Service support. Install this component only if requested by Customer Support.

Configuring imc FAMOS

Configuration of the imc FAMOS installation

In this step, you configure the imc FAMOS
installation. Select the editions you wish to install.
Note that all editions except the Reader-edition
require a license.

Follow the Assistant's instructions and select your
preferred language for the help files and example
files like projects, sequences and dialogs. Select
any optional components which you wish to install
along with imc FAMOS. Additionally, a folder for
sample files is needed.

Reference imc FAMOS editions

More detailed information on the imc FAMOS editions is provided in the imc FAMOS manual.

Once all products have been configured, the installation can start.
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3.3.3  Starting the Installation

Concluding the installation setup and starting installation

Before the installation, a system reboot is
performed. For this reason, first close any running
programs before continuing!

Confirm the reboot by means of the checkbox and
then continue (button: "Install"). Initially, the
required system components are installed.
Subsequently, the PC reboots automatically.

Warning Windows user account

After restarting, be certain to log in with the same user account with which you started the
installation process. Using a different user account can cause failure of correct installation of the
components.

List of components to install, following restart
(example)

After logging in, the actual installation of the
products begins. You are presented with a list of
which components are to be installed, which you
can confirm by clicking on "Install". The figure
below shows an example; the actual dialog may
appear differently depending on your respective
previous selections.

Next, installation of the individual imc products
begins.

Note Disabling the system start

While installation is running, the operating system is disabled from starting again, meaning that no
other programs can be started.

Concluding installation

When installation is finished, the following
message is posted.

Next, you can start imc LICENSE Manager in order
to activate your license. It is also possible to start
the imc LICENSE Manager later via the Start menu.
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3.4  Product Configuration / Licensing
imc STUDIO can be ordered and licensed/activated in various product configurations. Further details can
be found in the order forms or on www.imc-tm.com. For a list of all possible editions and components
(plug-ins), see the "Technical datasheet" or contact our Hotline .

Editions and components

The following editions are available for imc STUDIO, and each include a certain
basic package of components (plug-ins)/functionalities.

Edition Order code

imc STUDIO Runtime imc STUDIO-RUN

imc STUDIO Standard imc STUDIO-STD

imc STUDIO Professional imc STUDIO-PRO

imc STUDIO Developer imc STUDIO-DEV

Additional optional or individually licensable components (plug-ins) can also
be integrated.

Each edition is able to apply configurations created with a higher edition, but
not to modify them.

With an appropriate
"Engine" activated, any
edition can run the
configurations of higher
editions.

For the Edition Standard, Professional or Developer, the corresponding license is required. These can be
activated in the imc LICENSE Manager. The Edition Runtime is a restricted version, free of charge. You
can register this edition in the imc LICENSE Manager. There, select the option "Trial versions and
freeware".

Licensing (imc LICENSE Manager)

The software licenses are managed with "imc LICENSE Manager". After concluding installation, you can
start imc LICENSE Manager directly in order to configure your license (e.g. by means of the Windows
Start menu: group "imc" > "imc LICENSE Manager"). If imc STUDIO is started without an appropriate
license having been configured, the product configuration program opens, from where it is also possible
to start imc LICENSE Manager.

Follow the instructions of the imc LICENSE Manager. imc LICENSE Manager offers a separate
documentation. Start imc LICENSE Manager and click on "Help".

Changing the product configuration

You can change the product configuration in order to adapt it to the license purchased. For instance, if
during installation you have selected a different edition or if you have purchased a product upgrade. To

do this, start imc STUDIO and click in the menu bar (top right) on the symbol . The product
configuration assistant now opens. You can change the configuration to correspond to the licenses you
have purchased. Follow the instructions and close the assistant.

7
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Assistant for altering the product configuration

After completing the configuration, you must close and restart imc STUDIO to apply the new settings.

Changing the edition

In the dialog's upper region, a number of editions are available for selection.
The default selection is the edition currently being used. If you change the
selection, you can decide whether the available components are to adapt to
the selection. In most cases this is recommended, since this is the only way all
of the edition's functions will be available after an update.

Optional components are not affected by the edition selection and remain in
their previous state.

Please only change the
edition if you have
activated an
appropriate edition in
the
imc LICENSE Manager.

Changing the components used

Additional components (plug-ins) for the edition selected are available to choose. Some of these plug-ins
require a separate license.

In the bottom region of the dialog, the available components are shown. The set of components
currently used is selected by default (except subsequently to an edition change).

Column  Description

Aktive The component(s) is/are activated.

 The component(s) is/are deactivated

 Some of the components are activated. After clicking here, the components
underneath are deactivated.

Type The component requires an extra license in addition to the license for the edition.

 
 / 

The component can be activated for the selected edition without any additional
license.

Name  Product name of the component

Description
 

Short descriptive text about the component. More detailed descriptions of the
individual components are provided in the Technical Spec Sheet.

Activate/deactivate the individual components in the column "Active". Below the list, the information on
which additional licenses are required is presented.
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Note imc STUDIO Automation

The component "Automation" has its own independent license and for this reason always appears in
the list when selected. If you possess an imc STUDIO Developer license, you also have a Automation-
license.

FAQ

Why are there sometimes two components for the same product? E.g. "Automation Editor" and
"Automation Engine"

Answer: Many components are subdivided into their actual function, on one hand, and on the other
their respective settings interface. This distinction exist for the following reason: each edition can
run any function created with a higher-level edition, but not modify it.

In other words, using the component "Automation Engine", you can run Automation-Tasks in the
Standard edition. However, the Editor ("Automation Editor") is only available in the Developer
edition.

When should the "Engine" be deactivated

Answer: In most cases, it is not necessary to deactivate the engine if the component is not required.
However, be aware that every component activated makes resource demands.

At a minimum, keeping unnecessary components active slows down the launch of the system.

Disadvantage: All functions belonging to the deactivated components no longer work. Example
"Sequencer": Commands at Widgets, hotkeys/keyboard shortcuts, user-defined buttons, Metadata-
Assistant, user-defined events.

3.5  Start
Start the software by means of the associated desktop icon or via the Start menu.

Further, as part of installation an icon is set up on your desktop and - depending on your choice
during installation  - a symbol in the quick launch toolbar.

If no icon was set up (installation option), then open the Windows Start menu. There you find
the group "imc" and in it a link to start the product.

If product configuration / licensing  is missing, the Product configuration starts automatic.

Splash screen

Next, a splash screen appears, indicating that software components are being
loaded. Depending on the installation and the PC capacity, this could take
some time.

Loading the software
components after start
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Homepage - Start page

By default the Homepage is shown when the software is started. The Homepage shows certain functions,
depending on the particular product, as buttons. Click on the corresponding buttons, to select your
desired functions. After the first installation, the "Homepage" may appear as shown in the example
below:

Welcome Page (Example)

imc STUDIO starts with a simplified view

Along with installation of imc STUDIO, a number of Views are provided. Views in this sense are defined
designs for the user interface’s appearance.

imc STUDIO offers a wide variety of possibilities and functions, but the entire scope of these is not always
needed for a single simple measurement.

Note imc STUDIO starts with a simplified view

In order to make it easier to get familiar with the software, the program starts with a simplified view
with limited choices. All important functions for measurement and visualization of measured data
are available. The menu ribbon is structured in such a way that proceeding from left to right
accesses all of the Main windows .

Changing from the simplified view to View: Complete

You can switch to a different view at any time, in order to obtain access to all of the existing functions. To
do this, go first to the menu item "Extra" and in the drop-down list of views, select: "Complete".

Note Notes on the descriptions and the screenshots

The following descriptions and screenshots always pertain to the view with the full scope of
functions. Many of these functions are also found in the minimized view at another location.
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3.5.1  Device Connection / Network / Firewall
To use an imc measurement device, imc STUDIO must set up a connection via a network (mostly LAN).
Details on the network settings are presented in the chapter "Setting Up - Connect the device ".

Firewall

The firewall used might prevent establishment of a connection between the operating software and the
measurement device. If the software is unfamiliar to the firewall, then a corresponding prompt usually
appears upon accessing the network. This happens, for example, after starting the software and upon
first accessing the device (e.g. in a device search). Some firewall programs can also block access to
system and hardware-components.

In all cases, correct operation is only possible if the connection is not blocked. The following programs
are usually affected:

Program Default path

imc STUDIO: imc.Studio.exe C:\Program Files (x86)\imc\imc STUDIO...

imc DEVICES: imcDevices.exe C:\Program Files (x86)\imc\imc DEVICES...

imc DEVICES Service: imcDevicesService.exe C:\Program Files (x86)\imc\Shared

Example of the firewall warning under Windows 10

Windows firewall: Here, there is a distinction between private and public networks. For operation on
LAN, it is sufficient to enable "Private networks". Enable this access type. You may wish to read the
operating instructions for your firewall, and/or ask your administrator / IT-department.
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3.5.2  Main Windows / Plug-ins
imc STUDIO provides the framework for plug-ins. Plug-ins appear within imc STUDIO as main
windows. A plug-in can have one or more main windows.

The main windows appear in the Navigation Pane.

On the left you see an example of the Navigation Pane with the main windows Homepage,
Setup, Panel, Automation and Sequencer (Panel is selected).

To jump to one of the main windows, click on the corresponding button in the Navigation Pane.

Navigation Pane : Select this link to go to further information on operation of the
Navigation Pane.

Note Notes on the use of the simplified view

· When you use the simplified view , the Navigation Pane is hidden. In this case, in order to go to
the main windows Setup and Panel, use the menu ribbon.

· The other main windows can only be reached via the Navigation Pane.

· If you need it, you can show the Navigation Pane , or change the view .

Tool window

Most plug-ins have their own tool window (e.g. the Panel with the tool windows: Widgets and
Data Browser). The tool windows are described in their respective sections.

Reference See also

Tool window : Select this link to go to further information on operating the tool windows and for
a description of the tool windows belonging to the imc STUDIO frame.
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3.5.3  Important Settings

User and User groups

imc STUDIO has the ability to administer various users which are permitted to use the program in various
ways. For details see the section "User administration".

Options

Before beginning to work with imc STUDIO, you can change essential settings, such as the folder path
where the experiments are saved.

You can change the folder path in the options (under "Project Management" > "HDD settings"):

Ribbon View

Extra > Options ( ) all

Note Reading and writing access rights are required

Please note that this setting will apply for every user of imc STUDIO. Each user must possess reading
and writing access rights for the specified folder path.

3.6  Info / Version Information
imc STUDIO consist of multiple components (plug-ins). In order to see which components are included in
your package, click in the menu bar on the symbol . Then a pop-up window appears displaying the
product names and details on the components:

Version information (example)

With the buttons on the left side, you can change the list's depth of detail and how it is sorted.

With the buttons on the right side, you can start the assistant for the product configuration , start the
imc LICENSE Manager  or export the product selection.

While performing the export, you can save the contents as a file in XML format. For inquiries for Hotline,
it may be necessary to send it as an Email (see also chapter "Customer Support / Hotline ").
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3.7  Information and Tips

3.7.1  Changing Languages and Installing Additional Languages
If in the installation type "User-defined " the option "Install all languages" was not selected, then
upon conclusion of the installation, imc STUDIO is available in English plus, if provided, in the operating
system's language. In all other cases all supported languages are already installed.

Note Observe operation system settings

Please ensure that your operating system is set correctly to the display language. Some languages
require modifications to be made accordingly. In particular, the "System locale" must be set
correctly to correspond with the display language.

Otherwise, with some languages there can be problems with the characters. Languages affected
include Japanese, Chinese, Russian, ...

Changing the language

By default, the imc software will start in the same language as the Windows version installed. If this
language is not supported, then the English program version appears.

The language can be changed, irrespective of the Windows version. Use the program "imc Language
Selector". The program is found in the Start menu under the group "imc".

Note Constraints

Only the imc software’s texts are converted. Components which depend on the operating system’s
language setting are not affected.

Please only use one of the following two languages:

· Default: the operating system's language

· English

Any other selection may cause malfunctioning if the operating system and the imc programs use
different languages.

Installing additional languages

If desired, all other supported languages can be installed later (no data processing medium is required).

Note Which languages are be installed subsequently

In subsequent installation of languages, all languages supported are installed. There is no selection
possibilities.
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Step by step

· Administrator rights are required.

· Open the  installation folder of imc STUDIO (e.g. "C:\Program Files (x86)\imc\imc STUDIO..."), e.g.
with Windows Explorer or by means of the command line.

· There, open the folder "Languages"

· Run the file "InstallLanguages.bat".

· Wait until the script stops and posts the message "Failures: 0". This indicates that the installation
has completed successfully.

Note Instruction notes

If installation was unsuccessful, the necessary user rights may be missing:

· If "InstallLanguages.bat" is called via the command line, run the command line as
Administrator (context menu: "Run as Administrator")

· If "InstallLanguages.bat" is called via the Windows Explorer, run the call as Administrator
(context menu: "Run as Administrator")

3.7.2  Recommended Virus Scanner Settings
The presence of many channels can burden the PC if a virus protection program scans the data captured.
This may cause a jiggling display and high demands on the processor.

We strongly recommend removing imc STUDIO from the virus scan. Most virus protection programs are
able to classify individual programs as low-risk. To do this, please refer to the instructions for your virus
scanner.

Low-risk Default path

Add the program imc.Studio.exe to the list of low-risk
programs

C:\Program Files (x86)\imc\imc STUDIO...

Add the program imcDevices.exe to the list of low-risk
programs

C:\Program Files (x86)\imc\imc DEVICES...

Add the database path along with all subfolders to the list
of low-risk folders

C:\Users\Public\Documents\DB

Ensure that its data are not searched for viruses during reading or writing
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4  Setting Up - Connect the device
There are multiple ways to connect the imc measurement devices with the PC. In most cases, the
connection via LAN  (local area network, Ethernet) is implemented. See section "Connecting to LAN in
four steps " for the quickest way to connect PC and measurement device.

But there are also other connection types:

· Modem (TCP/IP with PPP)

· WLAN

· Radio modem (GSM, mobile phone network)

· Null modem (serial interface)

These are described in a separate chapter: Special options for connecting to the device.

The devices use the TCP/IP protocol exclusively. With this protocol, some settings and adaptations for
your local network may be necessary. For this purpose, the support of your network administrator may
be necessary.

Note

When using multiple TCP/IP connections, e.g. LAN, WLAN and modem, observe the remarks in the
chapter "Computers with multiple TCP/IP connections".

4.1  Connection via LAN

To connect via LAN there are two options:

1. The measurement device is connected to an existing network, e.g. via network switch or hub.

2. The measurement device is connected directly to a network adapter on the PC (point-to-point).

In a LAN, the first case is typically implemented. For both variants, different cables may be required!
Modern PCs and network switches are usually equipped with Auto-MDI(X) automatic crossover
recognition, so that having multiple various cables is no longer necessary.

1. Connecting to an existing network:

· An uncrossed UTP cable, e.g. CB-UTP-3 is necessary

· Connect the measurement device's LAN jack to a switch. Only with a hub or switch is it possible to
run multiple devices.

2. Direct connection to the PC (point-to-point):

· If you are using older PCs with AUTO-MDI(X) Crossover Detection, you need a special "crossed"
UTP-cable (Category 5, RJ45 connector, e.g. CB-UTPX-3)

· Connect the measurement device's LAN connector directly with the PC's LAN jack
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Recommended network configuration:

If possible, always use up-to-date network equipment in order to achieve the maximum transfer
bandwidth. The current standard (2014) is: 100BASE-T (Fast Ethernet 100 MBit/s) or 1000BASE-T (GBit
Ethernet). GBit Ethernet network equipment (switch) is backwards compatible, so that imc devices can
be operated with 100MBit Fast Ethernet.

The cable length between the switch and a PC or a device should be less 100 m. Use a shielded cable. If
the length of 100m is exceeded, then you have to insert another switch. If the system is being integrated
into an existing network, you must ensure that the minimum data rate can be guaranteed. If this is not
the case, you should use network bridging.

4.2  Connecting via LAN in four steps
The most common case is described below: the PC and the device are connected via cable or switch. The
device's IP-address must be set in the PC's address range. Subsequently, the device can be connected
with the PC. If a connection has ever been established previously, the software knows the device's
hardware configuration. In that case, experiment configurations can be prepared without any connection
to the device.

Step 1: Determining the PC's IP-address

Before starting the configuration of your measurement device, you should
determine your computer's IP-address (the following screenshots and texts
refer to MS Windows 10). There are multiple ways to do this, of which some
may not be possible on your PC, depending on the administrator rights you
have. In such cases, you should contact your responsible
administrator/IT-service.

Before determining the IP-address, connect the measurement device with the
PC and activate it.

The device's and the
PC's IP-addresses and
subnet masks must be
compatible with each
other.

To open the configuration dialog, use one of the following:

· Open the Windows Control Panel and search for
"View network connections"

· Select "View network connections"

· Open Windows' input box by using the keyboard
combination of Windows-key + R [Win-R].

· Enter the following command in the edit box:
control netconnections

The "Network Connections" window appears. Then right-click the mouse over the entry for your network
connection and then select the item "Properties" in the context menu once again. Then the Connection
Properties window appears.
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Select Version 4 of the Internet Protocol Version 4 (TCP/IP4) and click on Properties. Now the current
settings are visible. Please note the computer's IP address (3) and the subnet mask (4).

Select Internet Protocol (TCP/IP) Settings for TCP/IP

Warning

Be careful in changing settings, since if the same network card is used, there may be difficulties later
in the company network. Please discuss this with your responsible administrator/IT-service.

Note Obtain IP-address automatically (DHCP)

If "Obtain IP address automatically" (DHCP) is selected, no IP address is displayed. In this case, you
have to determine the current IP-address using the Command Prompt/Command line.

Note, however, that automatically obtained IP-addresses might change the next time the operating
system is started!
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Determine the IP address using the Command line

Open Windows' input box by using the keyboard combination of Windows-key + R [Win-R]. Type cmd
in the text box and confirm by pressing Return. In the command line window which then appears,
type in ipconfig.

Now you can read the IP-address of the desired network connection:

Result of the command "ipconfig"

In the example shown, the fixed IP 192.168.10.2 with subnet mask 255.255.255.0 is selected. For
measurement devices, any numbers would be suitable which begin with 192.168.10. and then do not
contain 0, 2, or 255. The 0 and the 255 should not be used, if possible, due to their special significance.
The 2 is the computer's number.

Step 2: Connecting the measurement device

When you connect the measurement device directly to your PC, you may
need to use a "crossed" network cable in some circumstances. If the
measurement device is connected to the network via a network hub or
switch, or a patch box, use an uncrossed network cable. Modern PCs and
network switches are able to switch electronically. Hence you can use both
cable types.

Use an appropriate
network cable.

Step 3: IP-configuration

Start imc STUDIO. Open the dialog for configuring the device IP address by clicking on the button "Device

interfaces" ( ).

Ribbon View

Setup-Configuration > Device interfaces ( ) Complete

If this button is not present in the view you are in, it is also possible to open the dialog after a device
search if it failed to find any new devices. Subsequently, a prompt appears asking whether to search for
devices with an inappropriately configured network interface. Close this message box by clicking "Yes".

Once the dialog starts, the system automatically searches for all devices in the
network. In the tree diagram, all available devices are indicated. If the device
is found in the group "Currently not reachable", you need to configure the
LAN settings. If the device is found in the group "Ready for measurement",
you can retain the current settings or view them. Select the device.

If there is any IP-
conflict, devices
affected will not be
listed.
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Picture 1: Display of measurement devices found and of the IP-address

If the configuration type: DHCP is used, the IP-address is obtained automatically from the DHCP-server.
If there is a direct connection between the device and the PC with a crossed cable, you should deactivate
the DHCP. If it is impossible to obtain any setting values via DHCP, the alternative values are used.
These could lead to errors in the connection (different networks, same IP-addresses, etc.).

Without DHCP, you must set the IP-address manually. Please note that the device's and PC's IP-address
must fit together, in other words that in the network mask only the portion representing the device is
different (see example).

Example for IP settings PC Device

IP-address  10.  0.  0. 34  10.  0.  0. 45

Network mask 255.255.255.  0 255.255.255.  0

In order to apply the changes, click on the button Apply. Wait for the device to restart and then close
dialog.

Note Connection via modem or WLAN

If the connection to the device is established via a modem or WLAN, start the program "imc DEVICES
Interface Conf iguration" by clicking on the button: "Advanced Configuration" (see picture 1). An
exact description is found in the software manual chapter: "Setting Up - Connect the device" >
"Special options for connecting to the device".
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Step 4: Integrating a device into an experiment

Now you are ready to add the device to the imc STUDIO experiment. If your device is unknown to the
system, first perform the "device search".

Ribbon View

Home > Search for devices ( ) all

Setup-Control > Search for devices ( ) Complete

Select the desired device: Once you click in the checkbox "Selected" for the desired device, it is ready to
use in the experiment (see Device Search - Known and Selected).

You can also select multiple devices for your experiment.

Now the device is "known". After the next program start it is available for selection. For further
information, see the documentation on plug-in Setup.

4.3  The Network

Optimize the network

You should observe the following notes for networks with high data rate, to reduce the risk of a data
overflow.

1. The network between switches/hubs and PC should be 1GBit/s

2. The actual data rate is decreasing with the number of channels. Avoid unnecessary channels.

3. The RAM buffer should be as big as possible, not Auto. See also RAM buffer time.

4. Save only channels you need to the internal disk.

5. Avoid curve window setting that need a lot of performance. Choose scroll mode. Avoid the rezoom
function after a long measurement duration. Don't set the sample points to symbols. Try to find a
curve window configuration, that shows no bucking.

6. Observe the recommended virus scanner settings ! It would check every sample  written to the
hard drive. That takes most of the performance of a PC and the hard drive.

7. Check the processor and network load with the PC task manager
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Example of a Complex Network

Theoretically, every type of network can possibly function. Until now, we have only considered networks
consisting of a PC and n imc Devices units. However, it is possible for example, to have 3 PC's, two
printers and n imc-Devices units connected in a network:

Monitoring

The PC on which imc STUDIO is installed is declared as the Master-PC, which configures the measurement
device. Various other clients can access the measuring device via the network (e.g. via imc STUDIO
Monitor or imc LINK, or, it is set up accordingly, using a browser via imc REMOTE WebServer).

The well-known network restrictions are also valid here. In particular, it is impossible for more than one
person to write to the same file. Furthermore, it is impossible for one person to open a file while another
writes to it. In general, all network restrictions that apply to files also apply to the individual Devices
units.

In consequence, the software con prevent multiple users from configuring the same device.

Using a second network

To avoid disturbing data transfer between devices units and PC's, a second network using a second
network card per PC can be set up. This second network can be used for transferring data between the
PC's.
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4.4  Firmware Version
The device software (imc STUDIO) always ships with a matching firmware version. The software only
works with devices having the right firmware. Upon the connection/preparation, the versions are
compared. If they don't match, the firmware update  is carried out.

If multiple firmware versions are installed on the PC, then a defined version must be selected for each
device. The selection strategy is set in the Options: "Setup" > "Device options" > "Selection of  the
imc DEVICES version".

Ribbon View

Extra > Options ( ) all

Option Description

Selection of the
imc DEVICES version

If multiple imc DEVICES versions are installed on the PC, a specific version must be
selected for the operation of each device. This option controls the selection strategy.

If only one imc DEVICES version is installed, this setting has no effect.

· Manual:  With "Manual", the system always asks which firmware version to use
when device are selected or an experiment is loaded.

· Automatic: "Automatic" avoids firmware updates. The version currently running
on the device is used preferentially.

· Always use latest: With this selection, the most current firmware version
compatible with this imc STUDIO version is always used.

Note Use of older firmware

Please note that a new firmware version not only contains new functions, but also reflects resolved
issues. These changes only take effect if the device is also using the new firmware.
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FAQ

Question: Which firmware versions support my imc STUDIO version?

Answer: There is a clear assignment regarding the compatibility with the firmware/firmware group:

imc STUDIO version assigned firmware group  

3.0 2.7  

4.0 2.8R3  

5.0R1 2.8R5  

5.0R3 2.8R7  

5.0R5+ 2.9  

5.2 2.10, 2.11, 2.13  

... ...  

For version 4.0 to 5.0, the applicable rule is: the assigned group and all older groups up to 2.8R3 are
compatible with the imc STUDIO-version used.

Example: the following firmware groups are compatible with imc STUDIO 5.0R1: 2.8R3 and 2.8R5.

As of version 5.2, the applicable rule is: the assigned group and all older groups up to 2.10 are
compatible with the imc STUDIO-version used.

Question: Can devices in the same experiment use different firmware versions?

Answer: Yes. If multiple devices are used, each one may use a different firmware version.
Prerequisite: The imc STUDIO-version used supports the firmware versions.

Question: Can I install a new firmware version without changing the imc STUDIO version?

Answer: Yes. Prerequisite: The imc STUDIO version used supports the firmware version.

Question: Is there a way to determine what firmware the device is using?

Answer: Yes.

· On the Setup page: "Devices", a column can be added: Device firmware

· In the Device properties.

4.4.1  Firmware Update
Every software version comes with matching firmware for the hardware. The software only works with
devices having the right firmware.

Once the program connects up with the unit, the device's firmware is checked. If the software version
doesn't match the device's firmware version, you are asked if you want to perform a firmware-update.

Depending on the device type, the following components are loaded automatically: Interface-firmware
(Ethernet, modem, ...), booting program, amplifier firmware, firmware for the signal processors.

Note

The firmware update is only required if the software was obtained as an update. If you obtained
your measurement with the software, no firmware update is necessary.
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Warning

Do not under any circumstances deactivate the device during the firmware update.
If any error messages appear during the firmware update, do not switch the device off, but contact
the imc Hotline. The firmware update may be continued with guidance from the Hotline.

The dialog for the firmware-update looks like this:

Start of the firmware update (example of a single device)
The state of the components of the firmware is diaplayed in the list.

Component Description  

Interface Interface-Firmware (Ethernet)  

Booter Start-up program for the device upon switching-on  

Operating system Device operating system  

Online Online-functions and hard drive controller  

Display Operating system of the connected displays  

Field bus Field bus  

Signal conditioners Amplifiers  

The following symbols for the individual firmware components appear in the list:

Symbols  

not current  

firmware conforms to current standards  

error occurred during update procedure  

— this option is not available on the device  

If no status indicators are displayed, no connection could be made to the corresponding device.

The duration of the update depends on the amount of amplifiers (can last up to several minutes). You will
be informed on the progress.
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You are notified when the firmware setup concludes successfully, as shown below:

Conclusion of the firmware update (example of a single device)

· Choose "Close". The device can now be used with the product software.

Warning Do not interrupt the firmware update!

Be absolutely certain to observe the following:

1. Under no circumstances should the device or its power supply be deactivated during the firmware
update!

2. The network connection may not be interrupted. Use a cable connection, not WLAN!

· For a variety of reasons, the firmware update sometimes does not conclude properly, for example
due to interruption of the power supply. For instance, the "handshake signal" at the end of the
procedure may be missing. In this case, no measurement channels would be displayed initially.
However, restarting the device and its software and performing the firmware update again usually
restores everything to normal.
It may be necessary to call the menu function "Update all components" in the FW-Update dialog's
Options menu. This scenario only results in permanent damage in the most rare cases, and it is very
worthwhile to repeat the procedure before sending a device in for repair.

· Behaviour under error condition, Windows cuts off the network connection without the user's
knowledge; but this can be prevented using the PC's Control Panel.
Background: During the firmware updates there is no data transfer for a few minutes and thus no
network activity; Windows detects inactivity of the connection and the following mechanisms are set
in motion:

a. Windows' energy saving mode switches the LAN adapter off, consequently interrupting the
network connection!

b. Windows switches to the next LAN adapter if there is one (some PCs have multiple adapters in
order to, for instance, access SAP or Novell in parallel, which are often running on separate
networks.)

c. Other scenarios are feasible, e.g. if switches are activated, which can also respond to missing
data traffic.

If an error message is posted during the firmware update, leave the device on and contact the imc
Hotline. It may be possible to continue the firmware-update under the guidance of the Hotline using a
service program.
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Note

Firmware logbook

The "File" menu offers a function for working with the firmware log file. Every action taken during a
firmware update plus any errors which may occur are recorded in a log file. This log file can be
displayed with menu "File" > "Show log f ile".
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5  Experiments, Projects and the Database
This chapter describes the interdependencies among the "Datenbase", "projects", "experiment
templates" and "experiments".

Experiment

The experiment includes a record of all settings needed for generating the measurement data as well as
viewing and evaluating them. The actual measured data are saved with the "experiment" to which they
belong.

You can create a variety of experiments to accomplish a corresponding variety of measurement tasks.
imc STUDIO always works with exactly one experiment and all changes are saved to it.

Among others, the following settings are saved:

· the experiment file (filename extension: "*.imcStudio"),

· measurement files and metadata,

· various backup files and administration files

Among other things, the experiment file contains all the settings configured in the main windows and in
the Setup-Assistants.

Each experiment has a unique name which is set when it is saved .

Measurement data

By default, the measured data are saved in the Experiment folder. They belong to the experiment. You
specify the data structure in the Device-settings under "Storage" (Setup page: "Devices" > "Storage").

Project

A project is primarily a collection of various experiments. The factory settings of imc STUDIO are
configured in such a way that only one project is present and that you are aware of it to the minimum
extent possible.

All of your experiments are saved in this project ("StandardProject").

Some options and configurations are not saved along with the experiment. For instance, they might be
saved along with the project and apply to all experiments belonging to the project. In some cases, you
can define what has to be saved where. E.g. when generating variables, you can change the validity scope
and, for instance, save it not just for that experiment but for all experiments in the project.

Whatever is saved at the Project level (and thus not with the specific experiment) is correspondingly
denoted at the locations affected.

A project can include:

· one or more experiments

· one or more experiment templates

· project settings (e.g. views, user administration and project-events)

After the first start of imc STUDIO, a standard project is set up in which your experiments are saved.
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Project view - working with multiple projects

When you activate "Project view", there is a project-based tree diagram in the Open- and Save-dialogs
. Here, you can create additional projects and load experiments from other projects.

You can activate the "Project view" in the options (under "Project Management" > "General options"):

Ribbon View

Extra > Options ( ) All

Option Description

Project view activated

To create more projects, you must activate the Project view. This option is
deactivated by default. (Information on Projects ).

There is an extended view available of some dialogs . Multiple projects can be
created and used.

· Only activate the Project view if you wish to use and manage
multiple experiments in separate projects.

· If this function is deactivated, some dialogs are displayed in
simplified form (e.g. "Save experiment" and "Open experiment"
are missing Project selection, for instance).

Datenbank

The database is the data repository for imc STUDIO. Here, the projects and their associated experiments
are saved. The database does not have its own settings and configurations.

The folder path for the database can be freely selected (in the Options under: "Project Management" >
"HDD Settings").

Ribbon View

Extra > Options ( ) All

Option Description

Database folder

Here you set where the "Database" is to be saved. (Information on Data
management)

The database is not user-dependent. Note that every user who is set
up in the system has writing and reading rights for this path.

Database conversion

If the database structure has been changed, you are subsequently notified.
One way this can happen is as a result of updating to a new version.

A conversion-dialog appears. You can convert the database or have it copied
beforehand. After the conversion, the entire database can no longer be used
with the older version.

Databases are not
downward compatible.

In the upper region, the reason why the database does not fit with the current version is noted. E.g., the
database may be too new or too old. In the list below, all databases found in the folder selected are
listed. The "Status"-bar contains information on the database.
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The following approaches are available:

Approach Description

Select an existing
database

Select the appropriate database and click on the button "Apply".

If it is necessary to convert the database, an additional dialog appears. Here, the user
is prompted to decide whether to use the database under a new name. If you
choose:

· no: the existing database is converted. It can no longer be used with the older
version.

· yes (recommended): the database is copied. Enter a name for the new database.
Now you have two databases. You will have a backup copy and can continue to use
the old database with the old version.

Create a new database Click on "Create new". Enter an appropriate name for the database. It will be created
in the folder selected (parallel to any already existing databases).

Change the database's
folder

Click on the button "..." next to where the folder is indicated. Select an appropriate
folder.

Here, select a folder where the database folder is to be created later. Not the
database itself. E.g. the default folder: "C:\Users\Public\Documents". The database
will be created in this folder, e.g. "DB".

Experiment Template

See: Experiment Templates

Note
Creating one's own files on an experiment - in the folder
"Meta"

You can create your own files on the experiment, such as metadata, imc FAMOS-sequences, info-
files, ...

To do this, use the folder: "Meta". First create this folder manually in the experiment path. If you
save or export the experiment under a different name, all files from the folder "Meta" come along
with it.
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5.1  Dialogs: Project and Experiment
The Project Management dialogs are described below:

· with "Project view" and

· with "Experiment templates".

By default, these options are deactivated, in consequence of which not all functions are available.
Options-dependent functions are mentioned explicitly below.

The dialogs following the functions "Manage Project", "New Experiment", "Save As" and "Open" are
structured similarly. The dialog is described below on the basis of "Project Management" as an example.
Not all dialogs feature the complete scope of functionality.

Example: Manage project

The dialog is subdivided into five regions (from top to bottom):

1. Address bar

2. Menu bar

3. List of all projects

4. List of all experiments and experiment templates in the selected project

5. Linked metadata information belonging to the selected experiment

By default, the regions 1,2 and 4 are displayed; the others can be activated if desired.

Region 1: Address bar

The address bar displays only the names of the database and the project selected. The bar has no
additional functions.



imc STUDIO 5.2 - Getting Started, Doc. Rev.: 4.13 -  2021-03-03© 2021 imc Test & Measurement GmbH

Dialogs: Project and Experiment 51

Region 2: Menu bar

Function Description

New

Create new project: Creates a new project in the selected database (a database must
be selected).

Create new experiment template: Creates a new experiment template  (a project
must be selected).

Import

Imports elements (projects, experiments and or experiment templates) from a file in
the selected entry.

The file can contain multiple elements. You can select either all or individual elements
for import. Additionally, the target name can be changed.

Be sure to first select the target correctly. You can only import a project if the
database is selected. You can only import experiments and experiment templates if
a project is selected.

You can only import projects if the Project view is activated.

Export

Exports the selected entries to a file.

Whole projects and individual/multiple experiments and experiment templates can
be exported to a file.

Manually created folders are not included with the export. The
exception is a folder in the experiment path named: "Meta ".

Delete

Deletes the selected entries.

Complete projects and individual experiments/experiment templates can be deleted.
If you select delete an experiment with saved measurement data, a prompt appears
for confirmation that you wish to delete the data.

/ Show/Hide Region 3 (list of all projects) 

/ Show/Hide Region 5 (metadata information) 

Regions 3 and 4: List of all projects/experiments and experiment templates

In these two regions, the projects/the experiment and experiment templates are listed. When you select
a project, all elements of the  project selected are displayed in the region at right.

Region 3 is only displayed if the project view is activated and the region is shown (via the menu

button: ).

Region 4 only shows the experiment templates if these are activated.

Region 5: Linked metadata information

The metadata saved with the selected experiment are displayed in this region. When an experiment is
saved, the metadata can be saved automatically along with it. In the Options "Metadata" > "Experiment -
Metadata" > "Setup page", you can select which source to use for the metadata.

Only shown if the region is shown (via the menu button: ).
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Reference Specialties

Dialog: New experiment

See: Creating an experiment

Dialog: Manage Project

See: Experiment Templates

5.2  Creating/Saving an Experiment
Each experiment has an identifying name which is specified when it is created/saved. Each name may be
used only once per project.

When you create an experiment (ribbon menu item: "Home" or "Project" > "New"), or when you save an
experiment under a new name, you are asked for a name. In this case, enter a unique name.

If the "Project view" is activated, you can additionally select the target project.

New Experiment

When you create a new experiment, it is generated from an experiment template (see "Experiment
template ").

· If experiment templates are displayed , select an experiment template.

· If they are not displayed, the preferred experiment template  is used automatically (at default:
"StandardTemplate").

All changes since the last save are discarded if a new experiment is created.

Save experiment as

When you save an experiment under a new name, a new experiment having the current settings is
created.

· Measurement data from the existing experiment are not transferred along to the new experiment
(exception: if the experiment was previously never saved; in that case a prompt appears to ask
whether to include these measured data).

· Files from the folder "Meta"  are copied and are available in the new experiment.

5.3  Experiment Templates
When you create a new experiment, it is generated from an experiment template.

The new experiment contains all properties of the selected template. In templates, all settings which are
saved will be saved also in an experiment.

After the first installation or after creating a new project, the project contains an "empty" experiment
template.
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Making experiment templates visible

To be able to use experiment templates, you must first make experiment templates visible. This option
is deactivated by default.

· Select from the menu "Extra" > "Options"

· In the Options dialog select "Project Management" > "General options"

Note

· Only activate this function if you wish to create multiple similar experiments.

· If this function is deactivated, some dialogs are displayed in simplified form (e.g. "New
experiment" without experiment template selection, among other things).

Creating experiment templates

Ensure that experiment templates are visible.

You can generate experiment templates from a variety of sources:

Source Description

From present settings The configuration currently set is used for the template.

From existing experiment Select an experiment from which to generate the template.

From default settings An empty template is created.

· Select the project (if the projects are not displayed, click on the white background, in order to avoid
selecting an experiment)

· Click on the button: "Manage Projects"

Menu ribbon View

Project > Manage Project ( ) Complete

· In the dialog, click on the menu item: "New" > "Add experiment template"

· Select a source

The experiment template is created from the source and and is available when creating an
experiment .

Preferred experiment template

You can mark an experiment template as preferred (template context menu > "Set as preferred
experiment template").

If the experiment templates are no longer displayed, the new preferred experiment template is
automatically used when a new experiment is created.
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6  Ribbon

6.1  Project Menu
The "Project" menu is available in every plug-in.

Some of the dialogs offer an extended view. By default, the dialogs are displayed without "project view"
and "experiment templates".

Project

Menu item Description

Manage
Projects

Managing projects and experiment templates

Save Project Saves the current project

Experiment

Menu item Description

New Creates a new experiment

Open Opens an existing experiment

Save Saves the current experiment

Save as

Saves the current experiment under a new name.

Additionally, the experiment is reset. The variables are assigned the respective initial
value (e.g. device variables = "0", or user-defined variables are assigned the respective
initial value specified). The event "Experiment_Loaded" is triggered.

Im-/Export

Menu item Description

Import / Export In this dialog you can import and export various components.

Measurement Data

Menu item Description

Save current
Measurement
Data

Save current
Measurement
Data as

In addition to the optional automatic data saving, you can also perform targeted
saving of the data currently in the PC (Current measurement) either during or
subsequent to the measurement.

See also Setup - Advanced Device Functions:
"Storage Options and Directory Structure" > "Controlling Data Storage" > "Targeted
Data Saving, or Saving Subsequent to Measurement"
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Note Without imc STUDIO Project Management

In the product configuration, the component "imc STUDIO Project Management" can be
deactivated. This is always the case in imc STUDIO Monitor, for example.

If "imc STUDIO Project Management" is deactivated, a number of limitations apply.

Among others, there is no longer any database. The dialogs for saving and opening experiments
match the standardized "Save As"- or "Open"-dialogs. Experiments can be saved at any desired
location. The saved measurement data are stored in the designated experiment folder.

The functions of the Project Management are listed in the Technical Spec Sheet.

The description of the Project- and Experiment-dialogs n the following pages pertain to imc STUDIO
with activated Project Management.

Changes in the menu without imc STUDIO Project Management:

Project - without Project Management

Menu item Description

Save Project
Saves the current project. In this case, all "Project"-settings are saved as
"Application"-settings and apply for all experiments.

Experiment - without Project Management

Menu item Description

New experiment

Creates a new experiment. The storage location is first determined by means of "Save
experiment/Save experiment as".

The device currently selected remains selected. However, the device’s configuration
will be reset.

Open experiment
Opens an existing experiment. The experiment can be be saved anywhere in the file
system.

Save experiment
Saves the current experiment at the storage location previously set using "Save
experiment as"; if no storage location had been determined yet, "Save experiment as"
is run automatically.

Save experiment
as

Saves the current experiment under an arbitrary name at any location in the file
system
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7  Navigation Pane and Quick Access Toolbar

Navigations pane

Maximized Navigation Pane
(example)

In the Navigation pane, the main windows of the installed plug-ins are
displayed as a tree diagram. To open/change the main window, click on its
corresponding entry.

The Navigation pane can be opened or closed, maximized and minimized.

· To maximize/minimize the Navigation pane, click in its top bar
on the arrow symbol.

· To open/close the Navigation pane, click on the upper region of
it below the arrow.

If the Navigation pane is maximized or opened, the main windows are
additionally displayed as a tree diagram (see example shown).

Via the tree diagram, it is possible to jump to different main windows
or directly to the pages containing the main windows. Using the
arrow symbols ( ) which are in front of the main windows, the
tree diagram branch can be expanded/collapsed.

You can hide the Navigation pane.

If you hide the Navigation pane, please note that your ability to navigate
between the main windows. For this case, you should add the command:
"Browse workspace" at suitable locations, for instance in the ribbon menu
("User-defined buttons").

To show or hide the Navigation pane use the dialog: "Tool windows
chooser ".

Quick access toolbar

The "Quick access toolbar" can be supplemented with various menu items. Which actions are available
for this purpose doesn't depend on what tab is currently displayed in the menu ribbon.

Using the context menu, you can either add or remove menu actions.

· Adding: context menu of the menu item in the menu ribbon (note: the menu ribbon may not be
minimized)

· Removing: context menu of the menu item in the toolbar

You may place the toolbar either above or below the menu ribbon.

Note Saving the configuration

The configuration of the "Quick access toolbar" is saved with the respective view.

The configuration is only saved whenever the project is saved.
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8  Tool Windows
Tool windows contain special elements for operating/viewing a main window. (For information on
operating the tool window: "Operation ")

Five tool windows

 
- The imc STUDIO frame's log book

 
- Four additional windows from the main window imc STUDIO Panel

One tool window belongs to the imc STUDIO frame and is always available:

· Logbook

The Logbook is always displayed and can be minimized. The other main windows' tool windows (e.g. for
the Panel) are displayed as soon as the respective main window is opened.

Note Not all tool windows are visible

By default, all necessary tool windows are displayed. All others can be displayed , if you need
them.

8.1  Operation
Tool windows contain special elements for operating and editing a main window.

Tool window (example)

Each main window has its own tool window, which is described in the
documentation of the respective component. Tool windows can be moved
and deleted.

By default, the tool windows are pinned to the main window (e.g. at the
bottom or right margin).

The picture shows an opened tool window ("Details"). It is pinned and
contains two additional tabs. If you click on one of these tabs, the
corresponding tool window opens ("Dependency Tree" and "Column Finder").

Three other collapsed tool windows are seen at the right margin ("Sensors",
"Layout Repository" and "Table descriptions").

A tool window is opened when the mouse is swiped over it.

As long as a tool window is selected, or if the mouse is located over the tool
window, the tool window remains open. Otherwise, it collapses to the side.
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Showing/hiding the tool window

You can either show or hide tool windows. To do this, open the dialog: "Tool window chooser"

· use the ribbon "View" > "Tool windows", or

· the button ( ) in one of the present tool windows.

Dialog: Tool windows chooser

The dialog: Tool window chooser opens.

Set a checkmark in front of the tool windows which you wish to have
displayed.

Pinning the tool window

Tool windows can be pinned. Pinned tool windows remain open even when no longer selected.

In order to pin a tool window, click on the thumbtack-button ( ).

Freely positioning the tool window

In order to freely position the pinned tool window, move the tool window's title bar using drag and drop
to the desired position.

Docking the tool window

In order to dock the tool window, use the drag and drop technique by grabbing the tool window's by its
title bar and moving it to the desired position. A Dock-symbol will appear at the locations which are
possible.

In the center of the targeted window (main window or
tool window), a cross appears. To dock the tool window,
release the mouse button with the mouse over the
desired position.

Dock at the top/bottom margin

Dock at the left/right margin

Insert as a tab in a different window (see example)
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8.2  Logbook
In the tool window "Logbook", messages of the categories: "Fatal" ( ), "Error" ( ), "Warning" ( ) and
"Information" ( ) are entered. The logbook entries indicate what problems and errors exist and provide
hints on where to find them and how to remedy them. Some actions performed are documented.

E.g., a note is entered in the logbook for every command performed:

· performed successfully ("Information") or

· otherwise "Error" or "Warning"

By default, the Logbook is opened when an entry any of the categories "Fatal", "Error" or "Warning"
occurs. By default "Information" category notes are entered into the logbook without any further effect.

Example of logbook entries

Each logbook entry consists of:

Parameter Description

Symbol for the category Fatal ( ), Error ( ), Warning ( ) and Information ( )

Time Time the logbook entry occurred

Code Logbook entry's error code

Message Exact description of the logbook entry

Sender The origin of the logbook entry

After a new imc STUDIO start, the logbook is empty. The logbook itself only displays messages which
occurred since the last start. Older messages can be opened with the "Logbook-Viewer".
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9  Views
The program's GUI is adaptable, so that for example the windows and columns can be positioned and
displayed according to the user's desires. The layout of the GUI is saved in so-called "Views". It is possible
to create separate views for various requirements.

The following settings are saved along with a view:

Region  Description

Window arrangement The imc STUDIO window's and the tool window's position and size

Menus Layout of the menu ribbon and the Quick access toolbar

Layout
· The last main window opened

· The tool window's layout (e.g. what metadata columns are displayed in the
Data Browser)

· The arrangement and configuration of the Setup pages (e.g. arrangement of
columns, such as metadata columns)

Note

Please note that only the positions of individual elements is saved. The existence and configuration,
for instance, of the Setup-columns (tables- and column descriptions) is saved along with the
respective project.

When you save a view, the whole project is also saved. This includes the current configuration of
the columns.

Saving views

In order to save the current view, select the menu item "Save View (as)":

Menu item View

View > Save View / Save View as (  / ) Complete

Extra > Save View / Save View as (  / ) Standard, Compact

All settings belonging to the current view are saved. These include the items named above.

Note The views are saved with the project

The views are saved with their respective project. When a view is saved, it is necessary for the
project to be saved. The system will notify the user accordingly.

Along with the project, additional settings are saved along with it, which affect the views:

· Setup table descriptions and column descriptions (these include, for example, additional columns,
such as metadata-columns, parameter set columns, ...) (tool window: Table Descriptions)

· saved Setup  complete layouts (tool window: Layout Repository)
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Loading views

In order to load a saved view, select the menu item "View" in the drop-down list of the respective view.
Here, all views available to the project are displayed.

After the selection the view is loaded.

The record of an experiment includes the view in which the experiment was saved. When the experiment
is loaded, the view also loads automatically.

Deleting views

To delete a saved view, select the menu item "Delete View".

Menu item View

View > Delete View ( ) Complete

Extra > Delete View ( ) Standard, Compact

In the dialog which then opens, select the view to delete from the drop-down list. Confirm your selection
by clicking on "Save project".

Restoring views

Views are not write-protected. They can be restored to their original state. The factory settings come
with a copy of all views created as part of the program installation.

To restore a view from the factory settings, select the menu item "Restore".

Menu item View

View > Restore ( ) Complete

Extra > Restore ( ) Standard, Compact

In the dialog which then opens, select the desired views. They are imported from the factory settings.
Conform your selection by clicking on "OK".

9.1  Exporting/importing views
When you export the view settings, a variety of project settings are stored in the export file.

Settings Description

Saved views
· table descriptions and column descriptions (these include, for example, additional

columns, such as "metadata columns", "parameter set columns", ...)
(tool window: "Table Descriptions")

· saved complete layouts (tool window: "Layout Repository")

Sensors
· user-defined characteristic curves/sensors (tool window: "Sensors")
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Export of views, metadata columns, sensors, ...

By means of the menu item "Import/Export", you can export the view settings:

Menu item View

Project > Import / Export ( ) Complete

Extra > Import / Export ( ) Standard, Compact

· Choose option "Export" and then the list item "Export views, meta data columns, sensors, ..."

· Choose an appropriate file name and path for the view settings file

Note Save the view beforehand

Save the view beforehand if you have made any changes (see "Views ").

Import of views, metadata columns, ...

Using the menu item "Import/Export", you can import the view settings to the current project:

Menu item View

Project > Import / Export ( ) Complete

Extra > Import / Export ( ) Standard, Compact

· Choose option "Import" and then the list item "Import views, meta data columns, ..."

· In the file selection dialog, selected the saved view settings file
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Thereafter you will see a dialog allowing you to import either all or individual view settings.

Entries having colored shading already exist in the current project. In this example, the complete layout
"New Page" is not yet present there.

Checkbox Description

Selected (left) Check this box if you wish to import the element

Overwrite? (right) Check this box if the element in the project is to be overwritten without any
confirmation prompt. If the box is not check-marked, a prompt appears to inquire
the name for the element to be imported. (Unless "Replace all items selected" is
check-marked.)

Replace all items selected Corresponds to "Overwrite?" for all entries: Check this box if you want to replace all
elements without any confirmation prompt.

You can select the following elements:

Element Description

Layouts All these elements belong to the Setup pages. Saved pages and saved designs, which
can be displayed on the pages. For more information on the complete layouts, see
the chapter: "Table Description and Complete Layout"

Views Her you find the imc STUDIO-views. The views  apply for all components of
imc STUDIO.
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Note New functions can be overwritten

Be aware that when making replacements, new functions may be lost if you import old
views/columns.

Importing defined additional columns

An additional prompt appears if

· discrepancies between existing Setup columns were detected or

· the file contains additional columns.

Select which columns to import and/or any to replace.

If the column already exists, a checkbox appears under "Overwrite?". If the box is not check-marked, the
column is automatically renamed. You can edit the name afterward. For more information, see the
chapter: "Creating and conf iguring additional columns".
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